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From the Chairman 
The Spectacular at Rugby is here again with two excellent speakers, trade stands, an instant exhibition of the prints 
you bring and a good probability of winning a major raffle prize. Apologies to those of you with other commitments 
on Remembrance Sunday but the venue is now heavily booked throughout the year and we had no choice of dates 
in the autumn. Every year your committee debate whether to continue with the Spectacular but it is difficult to think 
of a replacement for an event which attracts over 250 people and has such excellent support from the trade. Equally, 
it is very hard to decide to discontinue an event which has such good support. The challenge is to think of an 
alternative. Ideas please on a post card - or the email equivalent! 

Although Rugby is easy to reach, understandably it is too far for some members. So why not have something 
similar near you? As starting point to make this happen we need suggestions for venues and a firm commitment to 
help with the local arrangements. It is your Group and can be what you make it. Bo.r"{ Sel'\ior t:"R?S 

What's on Where: a selection 
For full information visit the regional websites on the back cover and see the DIGIT website 

DIG 2005 Exhibition 
Having been to Scotland and the Midlands, it can still be seen at: Kingswood Photographic Society, St Barnabas 
Church Hall, Warmley, nr Bristol on Friday 30 September 7.30 pm for 7.45 pm. Details from John Long ARPS Tel: 
0117 9672231 Email: iohnlonq@lineone.net; and Harrow Art Centre, Hatch End, London NW 1-12 November. 

Sunday 30 October: East Midlands Audio Visual Seminar 
Do you take digital photos, use PicturesToExe or dabble with linking images with music? Want to find out more 
about digital AV? The Narborough Parish Centre, Narborough, Leicester (3 miles from J21 M1/M69) 10.30 am to 
5.00 pm. Colin Balls FRPS and Keith Scott ARPS. Contact Brian Jeffs FRPS, 32 Parsons Drive, Glen Parva, 
Leicester LE2 9NS. Tel : 0116-2778452; Email: brian-ieffs@tiscali.co.uk 

Sunday 13 November - Spectacular 2005 
How the last year has flown . It only seems a short while ago we were enjoying Ian Bateman's and Steve Caplin's 
lectures and here we are looking forward to The Digital Imaging Group's SPECTACULAR 2005. This year is not to 
be missed with two top class speakers as well as a wealth of trade stands showing us all the latest and best in Digital 
Imaging. We are grateful to Malcolm Cartwright of Jessops for organising the trade stands and for getting them to 
part with the fantastic prizes they give for the raffle . 

The Speakers are Martin Addison FRPS, whose picture The Eye won a Ribbon at this year's exhibition. He has 
just produced an excellent book on Painter1 X - Painter 1 X for Photographers. Those of us that have used Painter 
in the past know what a fiendishly difficult program it was . Painter 1 X is much better and Martin explains it all in an 
easy to follow step-by-step fashion . If you have never tried Painter it can produce lovely painterly images from your 
photographs and is a complementary program to Photoshop. 

Adrian Davies, our other excellent lecturer, is Deputy Head of Arts, Media and General Education at North East 
Surrey College of Technology, where he has introduced various courses on digital imaging. He writes regularly for 
a number of magazines and speaks at various conferences and exhibitions, as well as being an active wildlife and 
natural history photographer. 

I do hope to see you there: it is the highlight of the Digital Imaging Group's year and well worth the effort of getting 
to Rugby. The Benn Hall is five minutes walk from the town centre with easy access from the M1, M6 and M40. 
Please use the special insert in the magazine to order your tickets. Giel'\'-{'., -ro.'{lor AR?S 

20 December Good Picture 2005 
Imaging Science Group of the RPS meeting at University of Westminster, Regent Street, London 10 am to 4 pm. 
Ticket £45: Concessions £25. Dr Mike Christianson Tel : 0208 424 5774. Application form from www.rps-isg.org 

DISTINCTION SUCCESSES We are delighted to congratulate the following DIGIT members who have recently 
gained distinctions. If we have missed your name from the RPS records, sincere apologies and do please let us 
know of your successes. It is good to see Greece featured in this group as well as the UK. 

ISO Level 3 : Antonis Karydis 

LRPS: Phillip Barker; Roger Barker ; Christine Carr ; Paul Cremer; David Dunn ; Peter Gawthrop; Philip Hack, 
I McIntosh; Vikas Monawer; David Naylor; Alan Pearson; David Shortland; Paul Walker 

ARPS: Andrew Bradford ; Martin Elder ; AW Milne ; Tony Poole; Claire Howarth ; Terry White 

FRPS: June Cook ; Andrew Gagg; Peter Stubbs; Keith Suddaby 

Digit is the quarterly magazine of the digital imaging group of the Royal Photographic Society. We welcome 
contributions from all members on any aspect of our special interest. Please send all contributions -
articles, photographs, comments - to the editor, Jim Buckley LRPS at iimbuck/ey.ba/tic@btinternet.com 

The intellectual property rights of all material in DIGIT remain with the authors 
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Making and Viewing 3D Pictures 
Ian Watt ARPS hopes members were tempted to follow up Clive 
Haynes' introduction to 3D in the December 2003 DIGIT and enter a 
new world of 'solid' photography. Although you have just missed The 
International Stereoscopic Union's congress, the practical tips and 
methods for viewing the results, and the references, will help those 
exploring 3D photography. Ian has practised pictorial photography as 
a hobby, and applied photography in his work in electron microscopy. 
A common add-on technique in both fields has been the employment 
of stereoscopy to portray depth information in photographic and 
microscopic subjects. More recently digital imaging has become 
another useful technique, making stereoscopic manipulations much 
easier than previously. Ian is UK Representative for The International 
Stereoscopic Union. 

Stereoscopic photography can be both 
fascinating and satisfying, especially when the 
experiences can be reliably shared with 
others. It is a many-facetted and continuously 
developing technology and Clive was naturally 
able to deal only with a few aspects of it in his 
article. I should like to add one or two extra 
details to his account, written from the 
viewpoint of a regular stereo worker who has 
found the manipulation of stereoscopic 
images very much facilitated by digital image 
processing. 

First, some pointers on acquiring images. 
The sequential technique Clive describes for 
stereo image acquisition can be a convenient 
introduction to the techniques - I started that 
way myself - provided there is no movement in 
the subject. To cope with a wide range of 
subject types the stereo base, or horizontal 
separation between the two camera positions, 
is usually calculated to be about one thirtieth 
of the distance to the nearest part of the 
subject (the one-thirtieth rule). Thus, to make 
a stereo image of a flower head from 30 cm 
range, a camera movement of 1 cm would be 
enough, with the lens stopped down as far as 
practicable. Having the camera on a tripod­
mounted slide bar is highly recommended for 
such a situation. 

If there is movement in the subject the two 
images of a stereo pair must be recorded at 
the same instant. Either a multi-lens stereo 
camera should be used or two cameras end to 
end on a bar, with the shutters synchronised. 
An alternative solution is to use an attachment 
on a single camera which by the use of mirrors 
places half-frame images from two viewing 
directions side by side on a single frame of 
film. 
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Second, how can you best view in 3D? 
With the stereo pair recorded, the requirement 
is to present the two images in a manner from 
which the brain can readily reconstruct the 
scene in 3D. This is the crucial turn-on 
or turn-off point for 
the aspiring stereo • t'4JK/ 
worker! There is a \ JJll" 
confusing variety of _ 
methods available for 
prints and slides. The 
essential requirement 
for any procedure is 
that each of the Simple viewer for side-by-side 
observer's eyes sees prints up to 60 mm 

only the appropriate left or right eye image, at 
infinity or a convenient viewing distance. An 
optical aid can use prisms, mirrors, lenses or a 
projection system to create this condition, 
starting from a pair of images in either side-by-
side or over-and-under configuration, as slides, 
paper prints or images on a computer monitor. 

The most effective way of showing stereo pairs 
to an audience is by projection on to a silvered 
screen, using plane polarised light to label the 
two images. For personal viewing a simple 
hand-held viewer will enable each eye to 
see its appropriate image. Popular print 

View Magic viewer for 
over/under prints 

viewing techniques 
in stereoscopic 
societies use either 
side-by-side prints 
on a card (9 x 18 cm) 
for Holmes or 
StereoAids viewers 
or over-and-under 
pairs (1 O x 15 cm) for 
the View Magic 
viewer. 



The alternative is to combine the two images 
in one red/blue, red/green or red/cyan print 
(the anaglyph) as described by Clive Haynes; 
there is then no size limitation and no lenses 
to look through - only two coloured filters- but 
no natural full-coloured images either! My 
own early days in stereo included working with 
micrographs from electron microscopes, when 
the images were greyscale by nature and ideal 
for anaglyph presentations. 

Third, sources of stimulation and specialist 
knowledge. There is a grave danger of being 
put off stereoscopy as a result of working in 
isolation, and it can be inspirational to sample 
the results provided by photographers who 
specialise in stereoscopic techniques. The 
Stereoscopic Society 
(www.stereoscopicsociety.org. uk) invites 
visitors to attend its meetings, held monthly in 
London and Coventry; they also hold a three­
day annual Convention. The International 
Stereoscopic Union (www.isu3d.org) has 
members worldwide and holds a world 
congress in a different country every other 
year. The latest was at Eastbourne in 
September 2005. Both of these organisations 
produce their own, very different, quarterly 
magazines with information about what is 
going on in the world of stereoscopy and have 

ScreenScope viewer for side~by-side view of larger 
prints or screen images. With the computer 

program 3D Viewer (www.stereoaids.com.auJ it is 
possible to zoom into selected regions of the 

image, still retaining the 3D effect. 

circulating postal portfolios. The website 
www.stereoscopy.com is very informative on 
many facets of stereoscopy and has two freely 
downloadable ready-made programs for 
creating anaglyphs. Finally, the computer 
program 3D-EASY (www.3d·easy.de) can be 
recommended for allowing stereo pairs to be 
input, adjusted and printed out in any of the 
formats mentioned earlier, as well as providing 
the means of combining, printing and viewing 
stereoscopic images from up to ten sequential 
frames by the lenticular and barrier viewing 
methods - but that is a much longer story! 

THOSE WERE THE DAYS! 

Early days with the twin Carousel 
projectors and an lmatronic 

Tony and Marjorie Furmston FRPS 
became hooked on audio visual back in 
the 1970s after seeing Pollock's 
Peepshow at Dewsbury town hall. In 
1989 they were awarded a Joint 
Fellowship (the last one ever awarded). 
Here they share some memories of 
those early days of AV. The way ahead is 
digital say Tony and Marjorie. Digital AV today 

dissolve unit 

We have enjoyed thirty years of 
making sequences from coloured 
transparencies with Tony's vast 
library of records, now superseded 
by CDs, providing suitable music. 
Unfortunately major heart surgery in 
2001 meant the end of lugging 
heavy equipment all over the 
country. Each Carousel projector 
itself was over the weight limit 
allowed by Tony's doctors. So what 
next? Digital AV was in its infancy 

I ~ ·!.~~~ .. :~::~~.~?-~ 
;,;,rs.UtTCt:i ~, 

Hand made poster 
announcing an 

early show 
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and we settled on Pictures to Exe 
realising the potential. But what 
about all those thousands of slide 
that would have to be scanned? We 
wisely decided not to look back, and 
recall learning digital imaging with 
Barrie Thomas - we hired him for a 
joint day of tuition at home! Now 
we realised that everything was 
possible and we could make the 
sequences we had always 
wanted to. 



Digital distinctions Day at Smethwick on 19 June 2005 

Members and 
guests enjoyed a 
great day at this 
workshop thanks 
to all the hard 
work of Glenys 
Taylor and her 
team. It was a 
pleasure to see 

Graham Whistler FRPS so much excellent 
demonstrates in the studio session work displayed 

around the Smethwick Club by those who had 
gained distinctions, and to see several 
projected including very clever audio visual 
sequences, masterminded by Maureen 
Albright. 

Graham Whistler's studio session taught us a 
good deal about lighting and we were fortune 

Jane Moyle LRPS 
at work in the 
studio session 

to have the family and their eggs as well! We 
all got good shots but the editor's choice for 
pride of place goes to Clare Whistler's eggs 
shown below. 

Guy Cowan 

Guy Cowan stood in at the last moment for an 
indisposed speaker and was an energetic 
presenter who provoked us to think outside 
the box. Although you should bear in mind that 
his website, www.etipsntricks.com, is still 
very much in development and has limited 
material, he has a special offer for DIGIT 
members at the moment. See the spring 
issue of DIGIT for more details or Guy's 
website. 

Eggs in One Basket by Clare Whistler LRPS 
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The Wizard of Oz 
Transform Again ... and again, and again 

Always a tremendously energetic and knowledgeable contributor to the 
DIGIT Folio, Tony Healy ARPS lives in Sydney, Australia. He has been 
taking nature photographs for almost 50 years and this was the subject of 
his ARPS, encompassing animal, vegetable and mineral. Tony says he 
specialises in the less obvious creatures: Everyone notices an elephant but 
it takes a bit of effort to see a jewel beetle! He has illustrated two books -
Australian Insects in Colour and Australian Crustacea in Colour, out of print 
now but available on Amazon. Tony has just satisfied one ambition: a visit 
to the Galapagos Islands. Fantastic, a natural history Aladdin's Cave he 
says. Here he shows us a technique to make wizard images. 

One of the features in Photoshop that can 
create extraordinary images from even the 
most mundane of subjects is the Transform 
Again command found in the Edit menu. The 
steps required to do this are very simple: 

The original 

1. Open a new file in Photoshop. For practice 
keep the· resolution small. Start with say 8 x 8 
inches with a white background. Later you 
may find a transparent background useful if 
you decide to drag it onto another layer. 

2. Open the image you want to work with and 
drag it onto the NEW file. You want some 
space around your image on the background 
so sit it in the centre. 

3. Duplicate the new layer by dragging it down 
to the duplicate icon in the Palette menu. You 
now have a background layer, layer 1 and 
layer 1 copy, as shown below. 
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4. With Layer 1 copy active go to Edit 
> Transform or use keystrokes Cmd-T (Mac), 
Ctrl-T (Win). You will now see a frame appear 
around the image with handles in each corner 
and a centre spot. 

5. Hold down the shift key and use one of the 
corner handles on the Transform frame to 
reduce the size of the image (say about 10%). 
Next place the cursor just outside one of the 
corner handles and it will turn into a double 
headed arrow. Use this to rotate the image 
clockwise on top of the Layer 1 image. Place 
the cursor inside the transform frame and 
move the whole frame a bit to the right and 
down. Press Enter to apply the command. 

6. At this stage the Transform move is in 
memory and still active. You now want to 
Transform Again. There are two optional 
keystrokes for this: either 

a Shift-Cmd-T (Mac) Shift-Ctrl-T (Win); or 

b. Shift-Opt-Cmd-T (Mac) Shift-Alt-Ctrl-T (Win) 

I used the latter. Now just keep repeating the 
key strokes and the image will keep repeating 
itself. When you have it in the form you like 
you can crop it, copy it, flatten it, add a fill to 
the background, drag it to another background 
or/and add a border. There you have your new 
image. 

You can make some variations now. In step 5 
with the Transform handles showing you can 
move the centre point around the inside of the 
Transform outline - see next page. This 
repositioning will make the repeat images 
rotate on a new centre and create a different 
swirl. This must be done BEFORE using the 
double-ended arrows to rotate the image. It is 



'" Transf. tif @I 25% (Layer 2. copy, RCB{ · 
• 6 !O : Ii 

A variation 

best done after you have resized and 
repositioned the image only. Should you 
decide not to resize the image but just move 
its position you will create a different rotation 
pattern. If you combine both these settings 
you will create another set of variables. 

Be aware that very minor repositioning of the 
first Transform command can make large 
differences when the Transforms are 

extrapolated. Therefore if you want to create 
an exact copy of an image with higher 
resolution using the original image it is best to 
record it in Actions (Window>Action) before 
the first Transform. The Action palette can also 
be accessed with the History palette. If you do 
not wish to keep the Action file you can always 
delete it. 

Flight. An image not resized - only repositioned 

The Transformed Image 
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Nikon D2X New Pro Digital SLR 

Graham Whistler FRPS, a professional photographer with 
extensive digital experience, is impressed by Nikon's 

new flagship 

I am now nearly six months into using the new 
camera, with its all-new 12.4 mega pixel 
CMOS sensor. After nearly four years of using 
the D1 X my expectations were high: Nikon's 
new flagship camera has not disappointed. I 
can find little to fault the performance of the 
D2X: image quality is stunning and the 
amount of fine detail captured will amaze even 
the most critical photographers! 

The robust camera body handles very well, is 
extremely responsive with zero start-up time, 
excellent write times (I am using 2GB Lexar 
x80 speed cards) and very intuitive controls. 
The new 11 point auto focus system is 
lightning fast with AF-S lenses and works well 
even in very low light. High speed continuous 
shooting even with 12.4 mega pixel RAW 
images is at 5 fps with up to 17 consecutive 
shots possible. The D2X also has a unique 
high speed crop mode allowing 8 fps and 29 
consecutive 6.8 mega pixel RAW images. 

As an . advertising and commercial 
photographer image quality is far more 
important for me than high speed continuous 

shooting. Nikon's all-new CMOS sensor 
delivers exceptionally pure colour rendition, 
wide tonal range and very clean image 
processing with almost no digital artefacts. 
The new improved 3D Colour Matrix Metering 
System works very well but I find it 
underexposes by about half a stop most of the 
time. Not a bad fault as burnt out highlights 
are rare with this camera and the exposure 
can be easily corrected in Nikon Capture 4.3 
with no loss of quality. There is little or no 
image noise at 100 - 300 ISO and only very 
slight noise in the shadows at 400 ISO. 
Images at 400 ISO are still very good and will 
produce high quality A2 or larger prints. I have 
not used the camera beyond 400 ISO - it is 
very rare for me to need more than 200 ISO -
but some reviewers say image noise is quite 
high at the higher settings. 

It is not all good news. I miss the IEEE 1394 
FireWire connection of the D1 X and find the 
USB2 works much slower; and with much 
larger files sizes (NEF RAW files are 20mb). 
downloading a full card of 99 images takes 
nearly 20 minutes. I enjoyed using my D1 X 

Studio photograph with D2X and 60 mm Macro lens Graham Whistler FRPS 
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connected direct to the computer for studio 
work with RAW images opening in Nikon 
Capture in less than 6 sec. Now the 20mb 
D2X RAW images take over 1.25 minutes to 
open via USB2 directly connected to a very 
fast Dell laptop PC with the latest version of 
l\likon Capture 4.3. Even processing loaded 
RAW images in Nikon Capture is slow. I hope 
Nikon will address this problem very soon as 
these new cameras with large high quality files 
need speedy post production processing to 
cope with a busy photographer's work flow. 

Nikon have retained the 1.5 factor sized 
sensor and not been tempted like Canon 
to go full 35mm frame size with the D2X. 
Full frame sensors may be the digital 
photographer's dream but they do place 
much larger demands on the lens. Nikon, 
by using the central 'sweet spot' strategy, 
are able to produce a new range of smaller 
(lower cost) very high quality DX lenses. 
Reviewers have said that there is little to 
choose between images from the D2X and 
the full frame Canons. However there is a 
major cost advantage: the new Nikon at 
£3500 body only is a full £1500 less than 
its Canon full frame rival. 

The D2X has many other advantages but 
one I value highly is the greatly improved 
lithium-ion battery power. With my D1X in 
a busy day I could work through three 
batteries. The all new smaller lighter 
batteries last for several working days and 
do not develop memory faults. The new 
much larger 2.5 inch LCD monitor gives 
improved sharpness and images can be 
reviewed almost as you take them! Out of 
the box I found pictures looked a little over­
exposed but later proved to be slightly 
underexposed when opened on the 
computer. I turned down the LCD 
brightness and am now able to get a very 
accurate review of my pictures as I shoot. 
In bright sun the image can still be hard to 
see but use of the histogram helps greatly. 
In-camera menus are quick and easy to 
use and custom settings can be created 
and stored. (I have created an exact 
colour white balance for my studio flash and 
store it in one of the preset memories.} The 
extensive system options including the new 
WT-2 wireless transmitter and GPS systems 
will be of interest to some photographers as 
will the high speed shooting. 
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The 20mb RAW files open in Photoshop CS2 
as 16 bit 70mb Tiffs. This size is more than 
large enough for 95% of my work as most 
clients are happy with A4 300dpi 8 bit 23mb 
files. At A4 size it is not all that easy to see the 
full advantage of the D2X with its 12.4 million 
pixel sensor compared with the 5. 7 million 
pixel sensor of the D1 X but once you go larger 
or start serious cropping the D2X wins hands 
down. You do need to work with the very best 
quality Nikon lenses to take full advantage of 
this camera's high resolution. 

Troy RPS Workshop portrait 

D2X 70 mm AF-S Lens and Studio Flash 

For me it is also the pure clean quality, colour 
and sharpness of the images. This is one of 
the finest cameras I have ever used. The no 
compromise fully viable professional digital 
SLR from Nikon is here at last. You need 
never shoot film again! 



How June Cook became Top Dog with her F Panel 

Little did I imagine where 
a spontaneous trip to a 
dog show at the NEC in 
Birmingham in December 
2000 would lead me. 
Having taken voluntary 

r redundancy from working 
as a PA to consultants in 
Public Health Medicine, 
making a trip to randomly 

photograph dogs and sending the pictures to 
their owners to find out if they wanted to 
purchase them seemed a good way of trying 
to bring in income for my new part-time career 
in photography. 

One of the breeders at the show, Dorothy 
Bridge, who also happens to live in Gloucester 
(and who later became my mentor), rang to 
say that she was delighted with the three 
photographs she had received. She said she 
ran a 'ring class' and wondered whether I 
would agree to take pictures of the owners' 
dogs one training evening. Not a problem. 
Why should there be when there were only 
twenty-seven dogs to photograph? 

Apart fro'!' one large strong lively dog pulling 
his way through the portable studio lighting 
and wires, and a nervous Borzoi wetting 
himself over the base and backdrop, the 
evening went remarkably smoothly. 

One sitting led to another and as new puppies 
came along, so did more orders. This 
progressed to dog shows, racing Afghans and 
whippets, and police dog handlers at work 
with their dogs. l\lot bad going for someone 
who is cat mad and has never owned a dog 
herself. 

It soon became evident that there are 
similarities between dogs and human beings 
when it comes to portraiture. The end result 
can be flat and uninteresting unless the 
attention is roused. Mentioning 'walkies', 'cats', 
squeaking a toy or even the photographer 
making whining noises can bring about a bright 
alert look and perk up the ears (talking about 
dogs, not humans). Then there are the 
ubiquitous hanging tongues and the problem of 
what to do about them: amazing how effective 
a squirt of lemon juice can be! 
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With the studio sittings, the more time the dog 
could be given to settle down, the better. 
However, the easiest models were the ones 
who came fully obedience trained, fully 
groomed, had clear young eyes and 'appeal'. 
Surprisingly, one of my most successful 
models turned out to be a porky wrinkly-faced 
pug called Elliott, so it didn't have to be a 
graceful Afghan or a pretty beautifully 
groomed Shih Tzu! And the unstinting help 
from friends and dog owners was a true gift, 
as the images would have been impossible to 
achieve without them. 

One evening a week was spent with my friend 
Malcolm getting to grips with the basics of 
Photoshop, poring over exercise books and 
brainwashing ourselves with CD tutorials, 
whilst endless cups of coffee went cold. Oh, 
the joy of watching as the print appeared from 
the printer. Okay, so it was garbage out at that 
stage, but it was magic all the same. Two 
days' tuition followed from my idol, the Adobe 
Photoshop guru, Adi Sethna, and he advised 
us to join the Midlands Digital Imaging Group, 
which we did. Due to the top class lecturers 
engaged by the Group, we achieved a level of 
control over our images we had never 
experienced before. This also led to me 
teaching Photos hop myself, which I still do on 
a one-to-one basis. 

Using the Epson 1270 and 1290, a variety of 
papers were tested and finally Permajet 
Papyrus was chosen, which tended to bring 
out the dimension of quality being sought 
from the dogs' coats. The camera used was 
a Nikon D100, with a 2.8 Sigma 24-70 mm 
lens. 

Dorothy Bridge, apart from providing a 
continuous stream of dogs to photograph, 
consistently encouraged me with the words: 
'You don't know where this will lead'. 'But I 
don't want it to lead anywhere - I am winding 
down, not up'. 'Doesn't matter, it will still lead 
you somewhere whether you like it or not'. I 
didn't take her seriously, but she proved to be 
right as it led me to the unthinkable, 
unreachable, incredible, quite unattainable 'F'. 

June's Panel itself and a selection of images 
are on the facing page. 



June Cook's F Panel 
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Double Digits 

Regular Folio contributors, Guy and Paula Davies, both LRPS, are 
keen photographers using Nikon D70 cameras. Digital capture 
releases inhibitions and many more photographs are taken. They 
both freely admit though that this means more go into the recycle 
bin! They took up photography seriously on joining a camera club 
in 1988, shooting mainly landscapes. Now retired and living in 

North Yorkshire, their styles have diverged and Paula has developed an imaginative, artistic 
style, concentrating more on close-ups and intimate landscapes, whilst Guy still 
concentrates on the broader open views. 

You've heard it said before, haven't you? "We 
go to the same places together and take 
pictures, but end up with quite different 
results." Well it happens to us too. Of course, 
sometimes we do stand side by side and 
come away with almost identical shots, and 
then it is a race to be the first to make a print, 
because whoever is first claims the use of that 
shot in the next exhibition or club competition. 
Not that we compete against one another very 
much really, because we seem to be 
developing our own separate and quite 
distinctive styles. 

Let's take a look at the two styles, bearing in 
mind that we are usually never far apart when 
taking pictures. 

Paula has developed an eye for intimate 
details in the landscape which probably 
started on a holiday at Lakeland Photographic 
Holidays. We were going to St Bees for some 
photography and on the way we stopped at a 
small church right on the coast. The church 
was built of large sandstone blocks and the 
wall facing the sea was very weathered and 
worn. The faces of some of the blocks were 
weathered into interesting patterns and Paula 
instantly got to work. One of her pictures from 
there is Sandstone Landscape No 1, which 
shows the face of one block only about 18 
inches wide. 
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Arriving at St Bees, the weather looked 
threatening but the light was good. Paula went 
out on the beach with John Gravatt and 
while they were out 
a squall blew in 
and the heavens 
opened. It was so 
bad they stayed put 
and when it cleared 
she decided to 
photograph the 
rocks they were 
standing on. The 
result was Rock 
Sculpture amongst 
others. The rest of 
the party, including 
me, had weathered 
the squall cowering 
behind a bus shelter! 

Her other developing passion is to make 
artistic and impressionistic pictures, usually 
from flowers. This started several years ago 
with some shots of tulips, and her latest flower 
picture is Study in Violet. 

She produced a different sort of flower picture 
recently. We had been on a camera club 
'evening out' to photograph bluebells in Newton 
Woods close 
to where we 
live. Bluebells 
are not easy 
but she saw a 
picture and 
was able to 
bring out the 
delicate 
feeling of the 
flowers, whilst 
at the same 
time hiding all 
the dead bits 



that seem to get mixed up with them. The result 
was "Bluebell Glade 11

• 

So what about me? The seaside town of 
Saltburn is not far away and, although it is on 
the north-east coast, the lie of the coastline is 
such that in high summer the sun sets along 
the beach, over the mouth of the Tees with its 
attendant industry. I love a good sunset and 
Saltburn seems to produce some good ones. 
My picture Saltburn Sunset shows it how I 
saw it, even if it was not exactly like that at the 
time! 

A different kind of sunset occurred one August 
when we were photographing the Transporter 
Bridge at Middlesbrough. We were on the 
north side of the river with the sunset 
backlighting the bridge when I turned round to 
see an enormous cloud over the steelworks, lit 
up in a fiery orange-red by the setting sun. 
The light was changing rapidly but I managed 
to get Tees View. 
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Another thing I really like is cloud formations. 
We had gone to the west of Ireland for a 
holiday and had some fairly mixed weather, 
with wind and rain somewhat inhibiting the 
photography. All the flowers that Paula found 
were blowing around madly, and all my 
grand landscapes were shrouded in cloud. 
However, it did brighten up on a couple of 
occasions and although the foregrounds 
were not tempting when it did, the clouds 
were really magnificent. One which I like is 
Storm Clouds at Inch. 

Finally, we all read in magazines that you 
shouldn't be put off by bad weather. Well it's 
not so easy is it? However, while in Ireland, 
we pulled into a picnic area car park one 
miserably wet day to rest and have a snack. 
Sitting in the car and looking out over the 
deserted play area, I was suddenly tempted to 
try a shot as the camera was within reach. I 
focussed on the wet window beside me 
and used a fairly large aperture, both to 
throw the background out of focus and to give 
a reasonable shutter speed for hand-holding. 
I had to cut out a large chunk of plain 
car-park and move the wing mirror up a bit 
to get what I felt was a pleasing result, 
Summer-Time Blues. 



Nature in the RAW 
Dr John Nathan LRPS is a semi.retired GP, now working part time. A keen photographer for 
twenty years, mainly wildlife and mountain scenery, he was Chairman of Central Southern 
DIG for three years until last April. His other great interest is walking and from visits to the 
Alps, Himalayas and Andes John confirms that carrying a SLR at high altitude on trek is 
difficult with battery failure, films cracking, and a hernia from the weight of it all! Compact 
digital cameras, despite their limitations, have been a godsend. With friends he has walked 
most of the long distance footpaths in South East England and elsewhere, always with a 
camera. This year John has walked in the Alps and Pyrenees and taken in the scenic 
splendour of Patagonia, at the Southern tip of South America. Patagonia is so outstanding 
that the cloud formations alone would satisfy a photographer, says John. Here are some of 
his experiences in coming to terms with RAW. 

John beside a glacial lake, below Fitzroy - a very 
impressive needle shaped mountain, impossible to 

photograph close up. Taken in a 70 mph gale from the 
icecap, only a mile away. A few seconds later everyone 

was blown over. 

We are constantly being told by the experts to 
take our pictures in RAW format. This article is 
to give a word of warning. I speak as a 
photographer who often travels to remote 
places. I do not pretend to be an electronic 
expert. 

John's overnight accommodation in a mountain hut at 
Cerro Torre in Argentina 
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There is no doubt that the RAW format gives 
control of the final image in a way never before 
possible. After the photo is taken you have 
control of exposure, shadows, contrast, even 
lighting conditions, before saving the picture. 

But there are problems, as I discovered on 
return from a recent trekking trip to Patagonia. 
I took some 1600 shots in RAW on a Canon 
EOS 1 OD. I used a 1 GB microdrive, then 
saved pictures daily onto a Flashtrax battery 
driven portable hard disk - not easy in a tent by 
the light of a head torch. l used 12.2 
Gigabytes of storage. 

Three towers of Torres de Paine Chile 

When I came home I downloaded them into 
my computer, creating 6 folders each of 
approximately 2GB. I tried to preview the 
pictures in 'My pictures' on Microsoft XP -
impossible. Each picture is saved twice, in 
RAW and as a JPEG, both visible only as a 
logo. I could however view the pictures in 
Adobe Photoshop CS Browse so I decided to 
save my RAW files. This took 17, yes 
seventeen, CDs. After opening pictures in 
Adobe Photoshop CS I had the option of using 
8 or 16 bit colour. 16 bit gives more shades of 
colour, so was the obvious choice for high 
quality prints. 



Perito Moreno Glacier Argentina 

Most of us would want to save images as TIFF 
files for permanent storage, after correcting 
the RAW images. My pictures were 5 - 6 MB 
as RAW files, then about 36 MB as TIFF files, 
ie approximately seven times the size of the 
RAW files. This would require 84 Gigabytes of 
storage, quite a lot even for a modern machine 
with a 160 GB hard drive. So, I have had to 
store them on DVDs. When you save the 
image, using Save As, unless you create a 
new title, it is not immediately obvious from the 
thumbnail which is the original RAW file, and 
which is the TIFF. You can find that from the 
metadata. 

But like other photographers, I want to both 
print pictures of the highest quality and to 
show them on a computer monitor or with a 
digital projector. There is no advantage in 
having a file size of more than approx 1.5 MB 
for the pictures shown on the monitor or TV, 
and it is convenient for purposes of slide 
shows to save them as JPEGs. I think that 
approximately 120 pictures are enough for a 
slide show without causing boredom. Saving 
JPEG images compressed solely for a slide 
show would use 180 MB for 120 slides, not 4 
GB as in the original TIFF format. I now 
found that I did not have an option to save a 
16 bit file as a ,JPEG, so I had to convert each 
image back to 8 bit first (lmage>Mode>8 bit). 
Resolution had to be reduced to approx 1 oo 
ppi to end with a file size approximately 
1.5MB each. This is fairly laborious with all 
120 pictures for the slide show and I am 
exploring the possibility of doing it with an 
'Action'. 

This is not meant to put people off using RAW 
files: but they are more difficult to handle and 
take up huge amounts of memory. So it is 
necessary to have a strategy for storage and 
later usage of the images. 

Summit of Paine Grande Chile 
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Linux & GIMP for Photographers: Getting Started 
Peter Gawthrop LRPS was given a digital camera (Nikon Coo/pix 7500) as a 
birthday present three years ago and thus took up digital photography; he now 
has a Canon Powershot Pro 1. He joined the RPS and DIG in December 2004 and 
has learned a lot from the Folio pages - and as a result has recently been 
awarded an LRPS. Though a beginner in photography, Peter has used Linux 
since the mid '90s and all his computers are Microsoft-free zones. He now uses 
the Linux tools GIMP, Hugin and lmageMagick to process his images. This article shows an 
easy route to try out Linux and GIMP without changing anything on your computer. Look at 
the web pages given in this article for much more information and let us have your 
comments and queries on the DIG Forum. 

Linux (www.linux.org) together with the 
associated GNU (www.gnu.org) project is a 
widely-used operating system developed by 
software engineers worldwide. It is free both in 
the sense of freedom and free beer ... 

Knoppix (www.knoppix.org) is a version of 
Debian GNU/Linux which runs off a live CD. 
This provides an easy introduction to Linux 
without touching your hard disk. You should 
save your work onto removable media eg 
floppy, flash or USB memory (See the Knoppix 
web site) and you will find that running from a 
CD can be slow. 

To get started do the following, noting that you 
should make sure that you back up all 
that you care about before starting. I 
cannot be held responsible for any loss or 
damage! 

Buy a Knoppix CD, for example from Use 
Linux (www.uselinux.co.uk) who do one for 
£2 at the time of writing. Put it into your CD 
tray and reboot the computer which should 
boot into Knoppix. If it does not it may be that 
your BIOS will have to be changed so that the 
CD boots first. 

At the Knoppix prompt just press enter 
(return). Eventually - this takes a couple of 
minutes - you should see a desktop appearing 
on your screen with a web browser. Exit the 
browser with the X in its top right-hand corner. 
The toolbar is at the bottom of your screen. 
Towards the centre are four buttons labelled 1-
4; these correspond to four different desktops 
- just stick with desktop 1 for the moment. 

The main menu button is the large K symbol at 
the left. Clicking on this reveals many 
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possibilities; K>Graphics is of most interest to 
photographers. Select Gtkam now. 

Gtkam (www.gphoto.org/proj/gtkaml) is a 
tool for extracting photos from your digital 
camera via a USB connection. Connect your 
camera to your computer's USB port. Click 
Camera>Add camera menu and click Detect; 
this should detect your camera which should 
appear in the left-hand pane; click on the 
triangle icons until you reach the photos - these 
should appear in the right-hand pane as 
thumbnails. Click on the thumbnail of your 
choice and then File>Save Photos>Selected, 
select the Desktop folder and tick the relevant 
boxes. Give the photo the name photo.jpg, 
click OK and it will appear on your desktop. 

Alternatively, if you use flash memory and a 
laptop, another method is to put the flash 
memory into the PCMCIA adaptor and a new 
folder (PCMCIA disk) will appear on your 
desktop. Click on this folder, and through to 
the folders it contains, until you find the image 
of your choice; drag and drop this image file to 
the desktop. Either way, you should now have 
an image file on your desktop which you can 
view by double clicking on it. 

GIMP (www.gimp.org) is roughly like 
Photoshop. Click on K>Graphics>gimp. The 
file menu is in the upper left hand corner; use 
File>Open to open your image (remember it 
lives in Desktop). As far as I know, Gimp can 
do everything that PS can. Tools such as crop 
and clone are in the main GIMP panel; basic 
colour menus are in Layer>Colors and basic 
filters in Filter>Enhance. 

Explore and enjoy! 



Camera buying 
· Alan Ray-Jones LRPS has been through the torture of choosing a new 
camera and spending his hard-earned cash. His experiences started a few 
years ago as he relates. The prices quoted may shock our younger 
readers! Alan, incidentally, although protesting that 'I am just a very 
normal amateur, so it doesn't seem to be in the genes' is the elder brother 
of Tony, the famous 60s photographer who tragically died young of 

leukaemia in 1972. The NMPFT at Bradford holds Tony's negatives and staged a 
retrospective exhibition last year. 

My first compact digital camera, bought in 
2000 for a round-the-world trip, was a 3 
megapixel Canon Power Shot G 1 , which cost 
well over £600! It served me very well, but its 
top shutter speed of 1/500 was limiting in 
bright light, and it was a very heavy beast for 
its size - not at all the sort of camera to carry 
everywhere in a pocket. In any case, 3 MP 
cameras don't cut the mustard when it comes 
to A4 or larger prints, and since 8 MP cameras 
were on the market in 2004 at prices under 
£1,000, it seemed time to upgrade. I think the 
old rule that computer owners may feel the 
need for an upgrade every three years applies 
now to computer-driven cameras! 

My first thought was to buy a Canon 300D, 
relatively light-weight as SLRs go, so that I 
could make use of the four Canon lenses I 
already had for my now rarely used Canon 
300 film camera. The photo magazines pretty 
much agreed at the time that the 300D was a 
best buy in its class. But it still cost a 
substantial amount (£670 with a lens or £570 
for the body on the internet in August 2004). 
Even when I was younger and living in 
Prague, from 1995 to 2001, I found such kit 
too heavy to carry round all day. In fact my 
favourite lens for the Canon 300 was a 28-
210mm zoom, which enabled me, on many 
occasions, to leave all the other lenses at 
home. 

Mainly because of the weight I considered 
only sub-SLR cameras, with picture quality 
and pocketability as equal top priorities. Of 
course I looked at magazines, in particular 
Digital Camera Buyer, for reviews of cameras 
costing around £700 at 2004 street prices. But 
to supplement these fairly brief magazine 
reviews, which are inevitably written for a wide 
audience, I also checked the details on Phil 
Askey's fine website, www.dpreview.com, 
which is independent of both manufacturers 
and retailers. The reviews of cameras on it 
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are, to me, quite breathtaking in their 
thoroughness. In addition, the site has a 
valuable comparison facility, which makes it 
easy to line up the specifications of several 
selected cameras from a shortlist, which can 
be compiled quickly by specifying features 
which are required - for example a shutter 
speed of 1/4000. The cameras considered 
best by Askey are described as 'highly 
recommended', but this is not an accolade 
which is given easily or often. Not surprisingly, 
the Canon 300D was 'highly recommended', 
as was the Nikon D70, but most of the best 
prosumer (ugh!) cameras were no more than 
'recommended'. It would have saved me a 
great deal of internet research time if the 
website had a tag for identifying cameras 
according to their pocketability, as well as 
those that are 'highly recommended', but at 
present this is not done. The quickest 
research method is to look at the conclusion 
given for each camera, before reading the 
detail. 

In the end I decided to be less ambitious 
financially, and my research produced a 
shortlist of three: the Nikon Coolpix 5400 (the 
successor to the Nikon Coolpix 5000); the 
Nikon Coolpix 5200; and the Sony Cyber-shot 
5 megapixel DSC-V1 - with a Carl Zeiss lens 
and a 4x optical zoom, first on the market 
in 2003. Another valuable feature of 
www.dpreview.com is a section giving users' 
opinions. The users of the 5400 and the 
Cyber-shot, as well as the reviewers, seemed 
slightly more enthusiastic about the latter, 
though clearly liking them both. Also, the 
Sony is smaller and lighter, so I decided to 
buy it, despite the lack of a tilt-and-turn LCD, 
which I find very useful on the Canon 
Powershot; and the fact that the memory is 
exclusively Memory Stick. Interestingly, the 
Sony was the least expensive camera of the 
three, but the only one with a 'highly 
recommended' rating. 



I then had to buy the camera. I would have 
used the net, but I wanted it the same day, so 
I visited my local camera shop (a branch of a 
national chain), armed with a print-out 
showing an internet price of about £275 
including post and packing. The shop had the 
camera on sale at £340, but offered it to me for 
£318. At another branch, in Tottenham Court 
Road, I was surprised to find it priced at only 
£300 (due to local competition in the area) and 
bought it there. I wonder how long such price­
matching will continue, and whether it will be 
affordable long-term for firms which have to 
maintain local shops and pay town-centre 
rates. Clearly high street photo stores are in a 
tough position, and we would be worse off 
without them, so I suppose we may eventually 
shoot ourselves in the foot by forcing them to 
accept online prices. Perhaps camera shops 
will become a rarity, and camera 
manufacturers will have to somehow finance 
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camera 'libraries' in the main towns, to enable 
users to examine cameras before buying them 
on the internet! 

The Sony camera was and is very good for a 
compact, and I continue to take it with me 
everywhere. But because I already had 
Canon SLR lenses, I succumbed when the 
350D - the first 'film quality' DSLR - came 
on the market this year at a price that I 
could afford. I added a Tamron 17-35mm 
wide angle lens after a visit to 
www.fredmiranda.com/reviews, to cover 
the deficit at the wide end produced by the 1.6 
multiple in focal length resulting from the small 
image sensor on the 350D. 

Now I have to see if I can produce some 
decent photographs with my new camera, and 
find out if my own experience confirms the 
website review. 

I Dr Leo Dosremedios ARPS writes from California: 
I 

As an 85-year old new member, I find the learning curve of Adobe Photoshop CS too steep, so 
I stick to APS Elements 2. Even that is hard and I am intimidated by the amazing images in 
DIGIT 27. Over the years I have accumulated about 300,000 slides. Of course, 99.9% are 
documentary snapshots but the remaining 300 winning slides (or at least the best 30) are worth 
tweaking digitally to raise them from a 95% quality rating to perfection. So this is my present 
project. 

I have not done too badly having won the RPS Travel Gold Medal for 2003 and Gold plus Silver 
in 2005. So I would advise older RPS members who find digital photography daunting, to do 
as I do. 

This shot of Mount Haydon, North Rim, Grand Canyon Arizona is from a slide that was 
scanned and darkened in Colour Variations. 

18 



Clear the Decks 

Maureen Albright ARPS Offer'$ some quick tips for those running audio visual 
presentations and competitions 

Some AV U$:Cr~ enjoy taking th~ir $:eflll~n<:es 
around lo oth~r c.ub::. anc yroups to project a 
show. If like me you have a (l~sktop v:hich is 
fill~ with progrctm icons and notes, it all looks 
VE1ry ch111cr~c a,,d d stracting ror your 
audience when you show the screen. You r,.,n 
of courst:! t:?asily clla·1gt:? th~ bi:tckgrour1d 
·Mage "rom thO$l;C pmildcd hy Mr Gat~s to 
one ol your choice. Visit Control 
Pancl>Disrlay,-Desktor. Here I'<>" will see a 
ist of Wi1dows-supplied ~ackgrounc iMagc$l;. 
Click OrowsE1 and you can find orit:: or your 
own images. Glick Apply to view the ct'cct and 
your iMa!)~ will appt:!ar i:tmong lhE:t WimJow~ 
pictures in tl"c list on 11"c left. 

Howeve' your new hack9r0lllld imao~ wil sli I 
be oovered wilt' al your many icons. You 
coI1ld oo lhrough an<.: 1.h:tl~le all 1h:?se familiar 
triends but atte· the show you might 'ind you 
rni:::;s U·t:?rn dr~i:t<.:fully amJ ha\"e to reir,trocuce 
them again. Th~re i:; another (lt1ickE1f a,,d morEI 
co11\"e11ierit way to clear your decks for just the 
'li~ht. 

Crei:tte a·1olher u:::;e· for your computer, 
My Tidy Alror £90, to take aro11od oo display 
to auciences. Visit the Start::>Control 
Pan~b-U~r accounts. Create a n~w ~ccount 
.inc m1Me it 'AV Shol-1''. This name will appP,ar 
011 lh~ welcome screen and ori the s1arl menu 
when you swtch on your coinpI11er. No more 
cisplaying al! your favourite program ioons to 
thEI E11,lir~ v:o'ld. ll's cool lo b~ clear nowl 

You will b~ i:lsk~d if you wi:t·It to create a 
computer adminiMmtor or a limitEIC aoco11nt I 
creat~ u·e former. I have two reasons for this. 
Firstly so,netim~s or, an AV day another 
person wist-es to show their sequence$1 or a 
·law program lh~y I·avt:? wri1t~n :::;o I 11~e<.: to tit:? 
able to load item:; onto the sy:;tem. S~condly 
t is ~a:::iy to delete tt-i:::; lype of aocou,t. 

Once you click Greate Account the new 
aoco11nt appE1ars for a,,y fulur~ u~. U you 
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s11ddP.nly nt:?~d lo ::.witch to i:tnoth~r us~r 
account it is very $1iMple. Click Start>Log 
Ofb-Us~r and lh~11 lh~ i:tccount name you 
need. Whe'l you fimt bring up your nE1'N U$1er 
scrt:?en. for ~xanple Al/ Show, your first task .s 
to ca et~ any ico,,s froM thP. scre~n whcll 
have transfe·rec across. nemember you a'e 
delE1lin9 0,,1~, lhe shortcuts and ·Iot your 
programs. 

Then tidy up tt-e tas-< ha'. If yoII are nmning a 
sequ~nct:? it is best it lhe task bar is not 
pr~sE1nt. So fight click o,, il anc St:?lecl 
Properties. Then you have soMe choices to 
make. For shov;s I prt:?ler to Auto H d~ Task 
bar. It w.11 immediate y drop cown anc 
<.:isapp~ar. If Y<nl take your cur:::;or dow11 to the 
001tom it will iI"lmediat~ly rP,app~ar 

Now yoII have a ni00 cl~ar, 1idy !>ackyroum; 
screen with which to start work. You c.an i' you 
wish pul shortcut:::; to your AVs droppec 
straigt-t O'lto thi$1 (create a bac-<gmund iI"laoe 
in Pholo:::;llop with the title::. listec and tl"en 
crop your short cut o~r the lille) or create 
three small :;t-o'tcut ioon$1: 

1. Shortc111 to th" fold.,, w1-.,,., you 1·old ~u 
your show AVt; anc any imagE1s tt-at yOll will 
need to access: 

2. Shortcul to yo~,r irilroductio11 n~m, paye 
wt-ic.h you will have r.real~d wilh i·wisi!>le 
buttons to just click aid start your $1how or 
cor11p~titio11:. 

~. Shortcut to any $10ftware proorain yoI, may 
be cemo,strating, or other folder:; you may 
, ,~e<.: to access. 

You will firid lots o' helpful AV Material on 

Maure~n':::; we:>sit~ at: 

Y.WW.ma1,r9enalbrighJ.CQm 



The Mersey River Festival 2005 
Anne Gilmore LRPS sends a rallying-cry from Liverpool. How about visiting to take some 
exciting shots: light on the ever-changing waters of the Mersey and the Bay, the great 
docks, powerful ships or the magnificent waterfront buildings. See you! 

2005 has been a special year on Merseyside: 
Liverpool won the European Cup to 
complement the anniversary of Nelson's 
victory at Trafalgar and we celebrated the 25th 
Anniversary of the Mersey River Festival's 
Photographic Competition and Exhibition. 

Despite poor weather, the Festival weekend 
was a great success with more visitors than 
ever. There was a range of activities to 
capture every photographer's interest from 
stunt-planes to street performers and a 
continental market. Of course, the river was 
thronged with craft of every description from 
tall ships, naval vessels and yachts to tugs and 
canal boats. 

The photographic entry continues to grow in 
size and quality. The real headache is 
selecting the Exhibition prints. So many 
excellent photographs could not be displayed 
owing to lack of space - a problem for most 
exhibition organisers. 

The Competition has three sections: The Main 
Section: People, Places and Events. It is 
repeated annually and continues to amaze all 
by producing fresh and original images each 
year; many reflect the Liverpool humour and 
record the diverse activities taking place on 
Merseyside. The Special Section, sponsored 
by the Mersey Basin Campaign in recent 

years, always has 'water' as its theme: images 
can be taken anywhere in the country. This 
year, the title "Water Ways, Water Days" 
produced wonderful atmospheric images and 
some dream-like shots taken in different parts 
of the British Isles. The final Section reflects 
the city theme of the year: Sea Liverpool 2005. 
The aim was to photograph life on the Mersey 
from its source to its mouth. There were some 
superb entries but they were perhaps a little 
narrow in their range. Few entries reflected 
the history, natural history, trade and industry 
of the area, subjects which create a 
fascinating mosaic of the river's life. 

At the pleasant and relaxed Grand Opening 
photographers can renew acquaintance over a 
glass of wine. We were pleased to welcome 
from amongst our loyal sponsors 
representatives from Calumet, Fotospeed and 
Kodak. 

A tradition of the Competition is that entrants 
are told they have won a prize -but they do not 
know which one until they arrive. In addition, 
each entrant has a chance to win something 
since all receive a free ticket for the Grand 
Draw with its excellent prizes. RPS members 
were well represented amongst the winners 
and two had their pictures chosen as a subject 
for meditation for the Radio Merseyside 
programme Thought for the Day. 

Pier Panorama by Keith Suddaby FRPS 
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The Photographers 'How To' booklet with Photoshop 
Sid Pearce FRPS 

In 1925 Bertrand Russell, the famous British 
mathematician and philosopher, penned a 
booklet entitled the ABC of Relativity. His aim 
was to explain Einstein's General Relativity 
without the use of diagrams or mathematical 
symbols. But in the end he did need to include 
a couple of formulae and a diagram. Sid 
Pearce does not have such an exotic or grand 
aim but his latest booklet for photographers, 
running to nearly 50 pages, relies on a 
straightforward text without diagrams and 
technical explanations - and his one 
photograph is on the cover! Sid's approach is 
to offer the reader a logical sequence of 
procedures and tips to deal with many of the 
common issues which confront the 
photographer who wants to enhance images 
using Photoshop. 

,.;;;~~--,.. 7 

The Phorowapher. I 
-.....-.. 

Photoshop. I 

Some years ago, in co-operation with Adi 
Sethna, Sid produced a number of pamphlets 
and now publishes his own monograms, the 
first of which Enhancing your image with 
Photoshop is still available. This latest booklet 
does assume a basic knowledge of the photo 
editing software and is bang up-to-date with a 
short section on camera raw formats. For the 
beginner it will be worth starting with the first 
publication since the latest offer does not go 
over the original ground and assumes some 
experience of adjustment layers, for example. 

These booklets are not intended to be 
comprehensive and detailed explanations of 
the way in which Photoshop works but short, 
comprehensible descriptions of how to 
achieve particular effects. 
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In Enhancing your image with Photoshop, 
the author begins by stressing the importance 
of keyboard shortcuts and moves on to cover 
layers and selections, scanning, layer masks 
and areas such as converting colour to 
monochrome. For example, here he offers us 
a range of methods including this one: 'A little­
known method of achieving a good Grayscale 
image, which I only recently discovered, 
is perhaps the easiest to achieve. It even 
retains the RGB channels. Bring a coloured 
RGB image onto the screen. Choose 
lmage>Adjust>Gradient Map. You will then be 
faced with a Gradient Map Dialog Box. To the 
right of the box is a small triangle which you 
should click. This will open the Gradient Picker 
drop-down palette. The third gradient from the 
left should be, by default, a black and white 
gradient. Click to get a very superior 
Grayscale which, as I said before, still retains 
the RGB channels. You can if you wish also 
alter the image tones by clicking in the large 
box in the Gradient Picker and moving the 
sliders.' This extract is typical· of the 
conversational style of the booklet. 

The more recently published How To booklet 
moves on from the basic techniques to more 
advanced methods which replicate darkroom 
procedures using Photoshop. Here we have 
more on adjusting highlights and shadows, 
enhancing detail in shadows, learning to use 
the history palette and other specialist uses 
of the program which allow you to simulate 
mist, lightning or shadows. Sid also deals 
with panoramas and resizing images for the 
Web. 

His booklet again adopts a conversational 
tone, and is not at raid to advise against the 
conventional wisdom. For example when 
talking about sharpening we have: 'For my 
part I am now going against the established 
norm by sharpening immediately after 
scanning. Why? My reasons are that 
whenever I scan a transparency, or bring an 
image from a camera or card into the 
computer, it is always slightly different to the 
original. Invariably it will be darker and slightly 
softer. For many years I have cropped and 
done colour corrections before any other 
image changes. 



T ·liS i::. much tile same ~~ mos1 
photogrnphe(S. Si'lre wE:t all rnake these initial 
changes, why shoulcl we no1 also yiw the 
irnaye a slight sharpen to bring it hack to i1s 
origi-lal state. irnmediately after scann n9. 
WhA,, I first l(iE:td a liyht sharpen I found lhat 
with the sharpeni'l!) of rhe imaye, I was atJ!e tu 
du uther corrections more ~r,cwale y and 
easily, Try it out. yoJ may· be plea!=lan1ly 
~I.rprise<i.' 

·1 hroughoJt both booklet:; we a(e offE:t(~d a 
,,11mlJ~( of ciff~rent ways of achieving a given 
re:;ult Sirl is nol p(~Scripli'le iri 1,.1ointin9 out a 
~ingle "besr methorl an<i ~ncou(aoes u::. to try 
out the icea::.. 

So, how docs the styl~, and lh" total l•ck of 
ciagrams and screen shot:;, work for the 
(E:ta<:t::r? Su·1,.1·isi11gly well in my view. ror one 

who wa::. tJrought up on ciagram:; ~nr. 
picture~, J thouyh1 I would miss a, 
explanatory scrAe'l ~hot to enable me 10 
follow thE:t texl. 1, fact, because of 1he relaxer. 
s1ylt:: ii i::. very easy to work throI.gh 1he 
tech,,irpes in bolh booklet::.. However, I thi1k 
the reacer woul<i finr. ii useful lo flay sp~cific 
pages which a·c of pa·tir.11lar interesl si,,ce 
lht::r~ Is ·Iu index. aid perhaps makA note!=l in 
the ma(oin aflt::r ex1,.1~Iimenting w th tie 
lech'lique!=l. 

Rolh booklets are available cirectlv from Sicl 
Penrce nt: 2~-12 I ace!>y Hoad, Grimsby, 
ME Lincolnshi·c, DN34 5DW. ThE>'/ cost £6.50 
am.J !:9 re::.pectively {inclLsive of po:;t a,1el 
packi,,o) a,,ct wot..l<: ,,ake a useful addiro, to 
your library of Photoshop volt..m~s with their 
range of tips, hint<:; nnd t~r,hniq11es in a ve·y 
, .. acable fo·rn 

LeOer to the Editor 

Tt1E:t Cditor. Digit Magazi'le. 

As a member of rite RPS UJ'gital imaging group I read your excQ/leflf maga/lne. I am in no 
way anti digital,· h? fact I ha\le been , . .Hgitlsirig bromide prints since 1993 on an Bafo/ flarhed 
.scanner and digitising negatives for many yeafS now. I just feel that the time has come for 
thos.e vyho afe interested in going foro11ard to look up from tfie Mble anu see what's out 
there. 

In my opinion, di9iral/y·prod11ced inkjer prin~ have reached a plateau, parlictrlarly in the 
monochrome department. Thev don't s.eem able to make that /Jnal step, seriously to rival 
the oid silvet Image. Latterly I have been s.eno'ing my carefully rnfl.nipulated monochrome 
digital files to a local lab fof pt1nting onto bromide papet 

I ha'lle made marrifold increases in mv mega pixel fating, by moving from 6 cm x 7 cm to 
5" x 4'. I ha\lB tP.Cently shot many unusual (particularly closA np) images with a Bob Rigby 
pinhole camera. I hal/9 ~d f>an Bufkholder's book - "Making Digital Negari11es for Contact 
Printing" - in which he explores the technique uf printing negatives. both in black and al.so in 
orange .safetight colour, onto acetate sheBts fot conract pflnting in your own darkroom. 
These so called 'Spectral Density NegatlVes' can also bB adjustsrl digitnlly, to print by 
alternative chemical proce.sses. 

ConrfolleU dlgltal techniques are very ·Nell snitA<'J to nccompany arrd supplement traditional 
chemical photography. PfoUuce your ,,..tell graded, digital, spott11rl and adjusted image and 
then the choices arc almost ~ndles.s. Whilst most of mv comrades arc happily StJapping with 
t~ir m~ga digitals, I can be seen stmggling to focus wJtf1 my head under the black cloth -
som11 would say ·In the sarrd'. I don't think so! 

,-Of,\ ltJ',,jfe\.-£Qd 
tom@teedulJ,plu!:i.<:0111 
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Easy Digital Competitions 
Nigel Plant LRPS has owned a camera of one sort or another since he 
was quite small. In the distant past he dabbled with both monochrome 
and colour (Cibachrome) printing but has only really got into 
"darkroom" work with the advent of digital. He still uses film, scanning 
transparencies into a Mac using a Nikon Coo/scan and gained his LRPS 
in 2002. He enjoys unusual camera angles and selective framing to 
create pictures out of everyday scenes. Southampton Camera Club is 
one of the leading clubs in southern England, providing a mixed 
programme of competitions and lectures, and organising a well 
established International Exhibition of Photography, with the 94th 

Exhibition planned for 2007. In this article Nigel explains how he runs 
digital competitions at the club. 

If you have a Mac, and cannot find a custom 
programme for running digital competitions 
here is an easy solution. If you don't have a 
Mac, read on. I'll explain why at the end. 

Most modern Apple Macs come with a clever 
program called Graphic Converter pre­
installed. Its main function is to act as a kind of 
electronic can-opener for almost any sort of 
graphics file imaginable. 

But it has a number of other useful tricks up its 
sleeve. 

You can use it to run a slideshow of a folder 
(including or excluding sub-folders as 
required) of images (and hide things like 
controls or titles as you choose) either as a 
timed presentation or changing on a mouse 
click. Other options available in the 
comprehensive preferences pane include 
things like scale, fade effects and the ability to 
overlay a logo. 

You can set the background colour (by default 
I think it is black) so your entrants do not have 
to mess around filling in space around images 
- unless they want the border bright pink! 

Best of all, you can nominate "Move" folders. 
Designed, I assume, to make sorting 
hundreds of images a breeze, it is ideal for 
competitions. 

At Southampton Camera Club, we allow four 
images. As the entries come in, I add a 1, 2, 3 
or 4 to the front of the filename, check that the 
images are within the permitted pixel 
dimensions and (for the purposes of 
generating a list) add the author's name and 
image title to the XMP metadata in 
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Photoshop's file browser so there is no need 
to open the images. 

Before the start, you need to create a series 
of new folders named for each score (for 
example 9, 10, 11, 12, 13, 14 and 15) and 
then assign F key combinations to each in 
the preferences for "Move" folders. Once the 
competition starts, I set the slideshow to 
auto-run at 5 second intervals to give the 
judge a chance to see them all and then 
change the preference to "mouse· click" for 
the second run through. As the judge gives a 
score I just hit the appropriate key 
combination and the image is moved into the 
folder appropriate to the score. The next 
image displays automatically. For club 
competitions I have a "Hold" folder as well for 
ones that the judge cannot make up his mind 
about. At the end of the competition you have 
them all sorted into their scores. This makes 
it easy to run through the high scorers again 
if the judges need to award medals or 
ribbons. 

A bigger competition such as an International 
might have more complex requirements. But if 
you have entered the metadata (or specified 
what entrants need to enter themselves) you 
can use file-cataloguing software such as 
Extensis Portfolio (Mac and Windows) to 
produce lists of each folder. 

"But I haven't got a Mac" I hear you cry. 
Unfortunately, Graphic Converter is a Mac 
only programme. But with a Mac Mini (16.5 
cm x 16.5 cm x 5.1 cm!) equipped with a AGP 
4x - ATI RADEON 9200 - 32 MB graphics 
card and DVI output available for as little 
as £280 ex VAT it might be worth the 
investment! 



KEY CONTACTS 
DIGITAL IMAGING GROUP 

Chair: Dr Barry Senior FRPS 
01425 471489 

barrv@Jittlepics.freeserve.co.uk 

Secretary: Glenys Taylor ARPS 
01823 282516 

or 01823 323986 
gf_enys.tavlor@tiscali.co.uk 

Vice-Chair and DIGROs: 
Ray Grace LRPS 

01249 716165 
rav.grace@BTOpenworld.com 

Treasurer: Peter Roberts ARPS 
01926 420105 

peter-roberts@ntlworld.com 

Webmaster: Bill Henley LRPS 
01453 825068 

henley@oneteJ.com 

Publicity and Website Updates: 
John Long ARPS 

0117 967 2231 
iohnlong@lineone.net 

Exhibitions: Alex Dutty LRPS 
01454 778485 

alexpatduftv@hotmail.com 

Graham Whistler FRPS 
01243 266053 

graham@gwpmultimedia.com 

Clive Haynes FRPS 
01905 356405 

clive@crhfoto.co.uk 

Maureen Albright ARPS 
01672 540754 

maureen@maureenalbright.com 

DIGIT: Jim Buckley LRPS 
01932 843893 

iimbuckley.baltic@btinternet.com 

DIGITAL REGIONAL OFFICERS 
Members wishing to attend regional digital imaging meetings should contact 

the organisers listed below for full details 

Eiger (East Anglia) 
Joy Hancock FRPS 

ioyandmike@woodview24.freeserve.co.uk 

Cumbria 
HarryBosworth 

harrvbos@aol.com 

Midlands 
www.midig.org 

Clive Haynes FRPS 
cJive@crhfoto.co.uk 

Central Southern 
Moira Taylor LRPS 

no1greenside@onetel.net.uk 

Wessex 
www.wessex-dig.org.uk 
Maureen Albright ARPS 

maureen@maureenalbright.com 

Scotland 
Alistair Knox LAPS 

akphoto@btinternet.com 

East Midlands 
www.rpsdigital-em.org.uk 

Bob Rowe ARPS 
bob.rowe@btinternet.com 

Western 
Glenys Taylor ARPS 

glenys.tavlor@tiscali.co. uk 

Southern 
Barry Senior ARPS 

barry@Jittlepics.treeserve.co.uk 

South Wales 
Vacant 

And finally, when will you send us an article for DIGIT? Remember that everyone 
is learning and all experience is valuable. We look forward to hearing from 
you, by post to 1 Aldenholme, Weybridge, Surrey KT13 OJF or email to 
iimbuck/ey.baltic@btinternet.com. 

Thank you. 
Jim Buckley, Editor 
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